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Things To Know

PGGP was written by an elementary teacher.   The first copy was sold in September of

1987. The main purpose was to write a program that prepares grades for the elementary 

teacher. That was the objective, and so far users find this is exactly what the program

does! 

First, remember, you are licensed to use PGGP at home and school for your student

grades.   (Your spouse can also use PGGP... hope you have a long and happy marriage.)

p.s.  I retired from educaton in 2005 after 35 years in the business.   I now have more time

to work on PGGP and my wife and I are enjoying ourselves very much.

TECH SUPPORT:

You can contact me at via e-mail:

gbeckman@pggp.com

or

(559) 674-7848

U.S. Mail should be directed to:

George Beckman

22353 Ave. 18 3/4

Madera, CA 93637

Watch for Updates and News at:

http://www.pggp.com

ORDERS:

Orders: M-F, 8-5 CST

1-800-520-7768

Visa/Master Cards Accepted

District Purchase Orders Accepted

Fax 228-255-7086

mailto:gbeckman@pggp.com
http:\\www.pggp.com


Send Checks To:

STAZ Software- PGGP 

320 St. Charles St., 

Bay St. Lewis, MS 39520

Site Licenses are available and P.O.s are OK.

Single: $49.00

Limited Site: $189.00

Full Site: $349.00

(Mac and Windows)

I am always happy to address any problems you may come across. If you think you have 

found a bug in PGGP, please contact me or go to the web site and look under Updates and 

Questions.
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Getting Started

New Class:

During the process of creating a new class the user can customize the program to their 

school setting.

Selecting New: (File Menu)

A dialog will appear asking if the user wishes to start from scratch, or use an existing 

database. This second choice provides the user a method to move a set of students and 

subjects to a new (empty) file when starting a New Grading Period.

The Creating Subjects Dialog Box

(Note that pressing Tab will move through the choices)

Number of Subjects:

Choose the number of subjects to be graded.

Limit: 16 Subjects.

Enter Class Size: Limit: 38

Enter the number CURRENTLY to be entered. New students can be added later at the 

bottom. (Students cannot be inserted unless they are replacing a student who moved, so if 

you have a combination class it is suggested that you split the class and leave a few 

blanks between classes. If this is done, include the blanks in the number of students.

Enter Number of Languages Supported:

Limit: 4

Enter Subject Names:

Subjects should be put in the SAME ORDER as they occur on the report card. Subject 

names should be eight letters or less to facilitate printing. Example: SocialSt for Social 

Studies.



Set the Subject Type:

Each subject can be either a traditional Academic grades or Effort Only grades. If a subject 

is declared an Academic subject, PGGP will keep a letter grade and effort grade for the 

subject. If Effort Only is selected then a single effort grade will be displayed. Both choices 

keep individual assignment scores as a percentage.

When the entries in the dialog box are correct click on DONE.

Save Your Work Now!
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Easy Setup

PGGP has an Easy Setup system. If you choose to use this Easy Setup, PGGP will 

establish a thread that will lead you. After following the Easy Setup thread, you will be 

ready to record grades. You can cancel the thread any time by clicking Cancel in any of the 

dialog boxes. When possible the dialog boxes contain default information, and but it is 

suggested that you review each carefully.

PGGP presents an opportunity to use Easy Setup an any time the user seems to be lost. 

The following instances will invoke the Easy Setup Screen:

1. Double Click PGGP and choose NEW in the File Menu.

2. Double Click PGGP and click anywhere on the grade grid.

3. While using PGGP for grade keeping or while looking at a Demo class, Choose New in 

the File Menu and click on "Start From Scratch" in the dialog box.

Don't do this every quarter or every year.  The New menu will help with these situations.
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Putting In The Names

After the a New Class has been created it is time to enter the class list. It is best to start 

with the slot #1. Click near the 1, and a Student Database card will appear. Press Tab to 

move from entry to entry.

You are encouraged to fill in all the information. At the least, fill in First and Last Name, 

Parent's Name and Gender. If you plan to send letters in more than one language see 

Setting Up For Different Languages.

It is suggested that you move from student to student by clicking the Square Button rather 

than Done. While this does not refresh the grade book in the background it will allow you to 

quickly enter student information.

Save Your Work Often!
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Importing Students

PGGP has the ability to Import students from a database file. It is suggested that you do 

this AFTER starting a New Class.

The Import file should be a TEXT file with a tab between each field and a return at the end 

of each student record. (A tab after each item, and a return at the end of each set of items.) 

The following items should be in each record:

First Name

Last Name

Parent Name

Address

Town

State

Zip Code

Phone

ID Number

Birth Date

Gender

Home Language

If an item is not available, place two tabs together.

As a side bar, we are using tabs rather than the traditional comma because student 

databases contain numerous commas as a part of the information.
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Starting A New Grade Period

Selecting New in the File Menu.

A dialog box will appear giving the user five choices.

Choosing Start from Scratch produces an opportunity to use the Easy Setup feature. See 

Easy Setup.

The next choices are built on the premise that the user has opened an existing class and 

chosen NEW.

Start A New Grading Period With The Same Students provides the user a method to move 

a set of students and subjects to a new (empty) file when starting a new grading period.

Start A New Year With Last Years Settings allows all formula and language settings to be 

maintained when starting a new grade book. This is useful if you teach a multi-lingual 

classroom, and do not want to translate the information yearly.

Start A New Set Of Subjects With The Same Students allows you to keep additional sets of 

subjects for the existing Student database.

I Am Not Happy With The Way I Set Up My Subjects is a tricky choice. This allows you to 

change the spelling of subjects. Remember, this does not move entries already recorded in 

a subject slot. If you wish to change subject order, go to Preferences in the Settings Menu. 

This is helpful if you forgot a subject or want to eliminate a subject at the end of the original 

list. Again, grades are being kept in buckets and changing the titles of the buckets will not 

change what is in the bucket. It is important to plan ahead. If you are really unhappy with 

your setup, consider choice #4 above. Put the subjects the way you want them, and 

reenter the assignments manually. And, of course, plan ahead.
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Updating Files

Files from earlier version of PGGP can be upgraded to 5.0 files. PGGP 5.0 will open PGGP

4 files. A brief message will be displayed, telling you that the file will be updated. PGGP 5.0

for Mac will append the extension .pgp at the end of the file. This extension can be helpful 

in determining which file is which after you upgrade.

The new file is a completely different format...the exact format that PGGP 5.0 for Windows

uses. This means that if the file is carried in to a Windows machine, it will open and save 

directly. However, earlier copies of PGGP will not be able to open the new files.

Odd Note:  PGGP 4.5 will open PGGP 5 files, but will loose all the Standards-Based data.  

If you are moving to PGGP 5, make sure you don't have any older copies of PGGP 

stashed around that may cause grief.
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Logic

To calculate averages, PGGP multiplies the percentages, times the weight, adds and then 

divides by the number of grades. Example: Sue has 4 grades.

  Weight  1    1    2   1

  Sue      92   74   63 N/A

PGGP adds the weights of the grades yielding a total of 4. (1+1+2=4) Note: the N/A is a 

null grade. ABS and a blank are also null. PGGP multiplies the grades times the weight 

and adds the products for a total of 292. (92+74+126) PGGP then divides 292 by 4, rounds 

to the nearest one, runs the number through the Formula and assigns the letter "C".

When computing an effort grade, PGGP looks at two things: The percentage of 

Incompletes vs. the number of assignments the student turned in AND the studentÍs

current Average in the subject. NOTE that this is an AND function and a lower percentage 

in either column triggers a lower effort grade.

It is also important to know that the Effort Grade is calculated on Incompletes and Late vs.

Number of assignments completed by a student. This means that a student absent five out 

of ten assignments and having one Incomplete has 80% of the assignments complete. A 

student turning in all ten assignments and having one INC has 90% of the assignments 

complete.
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Possible Problems

Both Mac and Windows attempt to give the user much flexibility in saving and retrieving 

files. The question is, where are the files being saved? Without lecturing on the wonders of 

the Open/Save dialogs, both platforms have mechanisms to allow you to change to the 

correct folder/directory. When we begin to fiddle with things, inserting a floppy, saving to a 

floppy and the like, we confuse the system. We know where we want everything to be 

saved, but after a floppy save, there can be confusion. Notice that I always have you start 

on the hard drive, where your grades are. The trick will be to make sure that after using a 

floppy to either open or save files, that you always navigate back to the place your grades

are kept on the hard drive and save there also.

Windows PGGP will behave if you have your main hard drive on C: and your floppy on A. 

PGGP will be trying to make the switches in the background. If you open your hard drive 

file first and you have the floppy in the drive when Opening or Saving to Mac, all will be 

well.

Macintosh PGGP will behave if you open your hard drive file first and put the floppy in after 

you Save To Windows or Open From Windows.

PGGP tries to notice where you are working and use that information when you use Open 

or Save As. It remembers this information and stores it for future use in the grades file. It is 

not possible to save this information when files are transferred to Window and back. OS 

10.3 or better has a handy tool bar in the finder. You may want to drag your grades folder 

there for easy access.

Visit the PGGP website for help and always feel free to write to me at 

gbeckman@pggp.com
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The Main Grade Screen

The main Grade Screen remembers the following information: Its size, shape, font face, 

font size, and what subject was last viewed. 

 Please note that before you begin randomly placing grades in cells, create a New grade

book by selecting New under the File Menu.

Once grades have been entered the following areas can be accessed...

The Grade Screen has a header across the top that always gives you the Date, 

Assignment Description, Weight, Points and if the assignment is a Rubric Assignment, the

standard.  Clicking on any of these buttons in the header will take you back to the

Assignment Screen where you can make changes.

The row under the header contains the column numbers, which can be thought of as 

assignment numbers.  Clicking on the column number will return the user to the Entry 

Screen for that assignment. Note that the method of entry, number of points, group entry,

etc. has been retained.  The Entry Screen is "magic" in the sense that unless the 

assignment has been entered by percentage, automatic calculations are made.  

The row under the column numbers show the weight of each assignment.  On the

Macintosh, clicking the weight will allow you to change the weight.  Window and Mac users

can change the weight by clicking the weight in the header.

The student names are listed on the left.  Clicking on a student name will bring up the

Student Database.

The columns to the right of the student names contain the grades.   Depending on the type

of entries (traditional, standards or a mixture), Averages are listed in one or two columns.  

The averages are always the latest average.   Because many schools have rules for how

standards are to be calculated, Preferences allows you to decide how to handle standards

entries.  If standards-based grading is used in a subject the word "Mean" or "Latest" will be

displayed above the column indicating whether the grades are being averaged or whether 

the latest grade for each standard is being used.   

In the main part of the grid, the current cell is highlighted. A highlighted cell can be 

changed any time. The current cell can be changed by clicking on the desired cell, using 

scroll bars, Enter (Return), tab or using the arrow keys.  It may seem odd that so little is



said about the main part of the grid.  This is because PGGP uses other screens to enter

information and grades.   This helps you see all the information about a student or

assignment at once, without having to scroll.
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File Menu

The "File" Menu gives the user access to document functions.

New

Selecting New allows a new set of Grade Books to be created. (See the New Files topic.) 

This is usually done at the beginning of the year, when using the program for the first time 

or when creating an empty book for a new grade period.

1 . Start From  Scratch-  This will start from absolute scratch, using none of the

information you have ever changed or used in PGGP.

2.  Start A New Grading Period With the Same Students- Use this to start a new

Quarter of Triemester.   All your formulas, standards, students database will be

carried forward and only the grades will be removed.

3.  Start A New Year with Last Year's Settings-  Use this when you are starting a

new year or are using PGGP with a different set of students.  All settings from the

open grade book will be kept.

4.  Start A New Set Of Subjects With The Same Students-  This is not often used,

but there may be times you want to create a special set of subjects or topics with a 

set of existing students.

5.  I Am Not Happy With The Way I Set Up My Subjects-  This is the "I goofed" choice.  

This will allow you to change the spellings of subjects or add subjects.   Warning:  This is

not the way to change the order of subjects if you already have grades in the grade books. 

You will only end up with Math grade in Reading.  Use the Subjects menu to change the

order.   If you add or remove subjects, make sure you change the number of subjects.   If

you add, add to the bottom of the list, unless you have not grades in the grade book.

Close

The Close command closes the current grade book window. Note that the application is 

still running and you can open another file by using the File Menu.

Save

The Save command saves the current grade book window. Remember to not make the 



title too long, or too cryptic. PGGP will append .pgp as an extension. Save Your Work 

Often! In Windows 95 and 98, PGGP attempts to save in the C:Program Files/PGGP folder 

(directory).  I suggest something like Mr. Beckman 5th Qt1 as a title, especially if you are

using a file server at school.

Save As

The Save As command is most often used when the user wants to change the name of the 

current document, or wants to save the document in a different folder. The dialog is 

presented, with "*.pgp" as a suggested title. Use a title that makes sense to you and PGGP 

will append the .pgp extension.

Open Last File

Selecting Open Last File attempts to open the last file saved in PGGP.

Import Class

Selecting Import gets a list of students from a database file. It is suggested that you do this 

AFTER starting a New Class. (See (Getting Started.)   The Import file should be a TEXT

file with a comma between each field and a return at the end of each student record. (A 

comma after each item, and a return at the end of each set of items.)

Import Standards

Selecting Import Standards will allow you to import a set or sets of standards.  The file is

not hard to prepare and can save hours in the long run. 

Print Setup

Selecting Print Setup produces the standard dialog associated with print functions.

Print Grade Book

Selecting Print Grade Book prints all pages of the current grade book. If all pages are not 

needed, select the page range needed in the standard print dialog box that is placed on the 

screen.

When the grade books are printed, they are suitable for use as paper grade books. Many 

users place printed pages in a binder, and use this in place of the standard grade book. 

Using this technique, the user can reprint pages to "clean up" pencil corrections.

Exit

Selecting Exit stops the program and returns the user to the Program Manager. If files have 

been changed and not saved, the user is prompted with a dialog, asking if the file should 



be saved.
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Sharing Files With Macintosh and Windows

(Also A Way To Save To A Floppy)

First, remember, you are licensed to use PGGP at home and school for your student

grades.   (Your spouse can also use PGGP... hope you have a long and happy marriage.)

PGGP can exchange files with Macintosh computers. Two things must be in place for this 

to happen.

1. You must use a copy of the Windows version of PGGP (Version 5 or better) and the

Macintosh version of PGGP (Version 5 or better). PGGP 5 will convert old PGGP files and 

read and write PGGP 5 files for Mac and Windows.

2. You can use a floppy disk but the "Key Chain" USB flash drives are very quick and 

handy.

Overview

When file sharing between Mac OS and Windows, think of the following:

1) You are going to start on one platform or the other. It makes no sense to enter 

information twice. We will call this the starting platform.

2) You are going to be moving files back and forth between the two platforms, but you will 

always save the information on the hard drive of each computer.

Here's a typical scenario. Please read all of the following.

Windows

a) Start PGGP

b) Put the USB flash drive in a USB port

c) Go to the Open menu Item in the File Menu.

d) Select the file and Open it.

e) Immediately save the file on the hard drive. (This is the tricky part.  You must be sure

you are saving to the C: drive again in your grades folder. PGGP will try to switch but 

file:///C:/DOCUME~1/Owner/LOCALS~1/Temp/PGGP%20Help.chm/pggp0043.htm


please check.)

f) Work with the grades until your heart's content.

g) Save the File on the Hard Drive.

h) Put the USB flash drive in and Go to the Save As item in the File Menu. Navigate to the 

desktop and to the USB disk.

i) Carefully carry the USB drive to the Mac.

Macintosh

a) Load the class from your hard drive into the grade screen with Open File under the File 

Menu. This helps PGGP know where you keep your grades on the hard drive. (Of course 

the first time you can't do this. You could load the Demo Class file.)

b) Go to the Open Menu and put the USB flash drive. Navigate to the desktop and then to 

the Flash Drive and contents will be displayed.

c) Select the file from Windows and click on Open.

d) Immediately save the File back to the Hard Drive. This is the tricky part.  You must get

the file saved on the hard drive in the correct place. In certain conditions you may have to 

click on desktop and then find the Pretty Good Grading Folder. Unless you are bringing a 

class for the first time I suggest using the same name as was used moments ago to get the 

file from the hard drive. (As in a.) The Mac will ask if you want to replace the original hard 

drive file. The answer is Yes.

e) Work with the grades until your heart's content.

f) Save your file using Save in the File Menu.

g ) Go to Save As and slip in the USB. (It will take a second for the files window to refresh) 

If it is already in, click on Desktop and then the USB drive.

h) Save the file on the USB drive.

i) Carry the flash drive carefully to the Windows machine.

Notice that the above cycle will assure you that your files are saved three places: At home 

on one machine, at school on another and on the flash. (Which will die some day unless 

you loose it first.)

There are two kinds of computer users who have not lost information. There are those who 

have not lost any information because they have backed up their files, and there are those 

who have not lost any information... yet.

Well, that took a while. This does work. You can do it other ways, I am sure, but please, 



please do not carry all your grades around on one floppy or flash drive that is going to quit. 

Say it with me, "All Floppies and Flash Drives eventually Quit". Of course they usually fail 

about two seconds before report cards are due.
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Importing Standards

The database is shown here in a word processor. These were copied (and doctored) from 

a web pdf. These are California, 5th grade, Language Arts standards. 

There are only two fields. The first word is a KeyWord.   The second is the information that

is related to that key.  The two fields are separated by a tab and the last field and the next

record are separated by a Return (Enter).

Key words can be:  (In other words each record of the database contains the following

fields.)

Grade:  Grade Level

Domain: General heading such as Language Arts 

Strand:  Most like a traditional subject title such as Reading or Writing



Whole Numbers:  1, often written as 1.0.

Subgroup:  These are for non numeric headings.  (CA tosses these in as dividers.)

Standards:  Can be 1.1 or A, B, C.   What ever your heart desires

Rubric:  The instructions (text) of the standard.

So, if I had typed this, I would type Grade and hit Tab, type 5 and press Return/Enter. 

That's all there is to it.

When Grade appears, the number following will be used in all records until Grade appears 

again in the file. This is true of all the key words in the first field. 

This is handy because the person creating the database does not have to continually 

prepare all the fields, many of which are repetitive.

As districts and teachers prepare databases for PGGP, I will be happy to share them. A set 

of CA standards have been prepared.
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Copy

In the Edit Menu, you can copy a column of grades.   This is handy if you want a set of

grades in two subjects or if you put a set of Spelling grades in Math.  Only one column at a

time can be copied. 

Paste

In the Edit Menu, once a column of grades has been copied it can be pasted into another 

column in any grade book.   You can paste it in another subject.   You will be asked if you

want to insert or add the column.   If you insert, the column will be place in the column

selected and the existing column and all columns to the right will be moved to the right.   If

you add the column it will be added as the next column in the grade book.   If you do not

quit PGGP you can open another grade file and paste it there.   There have been users

who became confused and had grades in two files.   While time consuming copy and

pasting will allow you to get all the grades in one file.
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The Assignment Menu

Choosing any one of the four methods of grade entry (Quick Entry, Percent, 

Number Wrong,  Number Correct or Rubric Scoring) will produce a dialog that

allows the user to select the information for the assignment. Pressing Tab will 

move through the various settings.

Each assignment  (not entered by Rubric Entry) can be given a weight. Weight simply is a

way of assigning importance to an assignment. PGGP uses a relational weight system.  It

does not create categories... e.g. Tests are worth 50% of the final grade.  An assignment

with a weight of one (1) is figured into the average once. If an assignment is given a weight 

of two (2), the assignment is figured in twice (as if it were entered in two columns). While 

this method of weighting grades is quite different from other electronic grade books, it 

produces a much simpler system* and one your students will understand. You can weigh

daily work 1 and quizzes 5 and even the youngest will understand that the quiz is worth 5 

homework assignments. Please not that you are not creating categories for assignments, 

just adding it in to the mix X times.

Once the assignment is set up, the Grade Entry Screen is displayed and allows the user to 

enter grades. Students are listed in order. It is possible to move to a student by clicking on 

the entry column or using the arrow keys. Enter will also pass by a student leaving the 

grade untouched. Clicking on the student's name will display the student's database.

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears in 

the cell with the grade. If the grade was already marked Late, the "L" disappears and the 

grade is no longer late.

* Telling a fifth grader he got 82% on a test worth 8 practice assignments is easy for him to

grasp.  If you tell him he got 82% on one of three tests that make up 60% of his grade, you



may be met with a blank stare.
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Grade Entry Screen

The Grade Entry screen is a double column screen that allows all the students to be seen 

at once. This is the "magic" screen where Quick Entry, Percent, Number Wrong,  Number 

Correct or Rubric Entry will do their special thing. For instance if using Number Wrong with

34 points, pressing a one (1) and return will cause PGGP to calculate a 97% for that entry.

Note:  If students are missing in the Grade Entry Screen, you may have set the Student 

Number too low.   

When returning to the Grade Entry Screen the computer places AN ESTIMATE of the 

original raw score when using Number Wrong, Number Correct or Rubric Entry. (Trying to 

reverse engineer a rounded number, can cause an occasional 1 point difference. The 

number displayed will result in the existing percentage score.)

It is possible to move to a student by clicking on the entry column or using the arrow keys. 

The return key (Enter) will also pass by a student leaving the grade untouched. Clicking on 

the student's name will display the student's database.

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an 

"L" appears in the cell with the grade. If the grade was already marked Late, 

the "L" disappears and the grade is no longer late.
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Quick Entry

The Quick Entry can be thought of as a Letter Grade Entry. All grades are entered with the 

left hand, placing the pinky on the 1, ring finger on 2, etc. Each key press caused the letter 

grade and a predefined percentage (which can be set by the user in Settings) to be 

entered, e.g. pressing 4 will cause an A to we entered and 95% assigned to the A in the 

default setting.

4= A (Press 4)

3= B (Press 3)

2= C (Press 2)

1= D (Press 1)

0= F (Press r)

N/A (Press 5)

Please note that this "Quick Entry" is very generic and cannot meet the needs of all. 

However, for "credit" type assignments, this can be very effective. The value of an "A" can 

be changed by selecting Quick Entry Setting In the Settings Menu.

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears in 

the cell with the grade. If the grade was already marked Late, the "L" disappears and the 

grade is no longer late.
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Percent Entry

The Percent Grade Entry allows the user to type percentage grades. Pressing ENTER tells 

the computer that entry is done and the cursor automatically moves to the next student. 

The computer does not understand a grade greater than 100% and will convert higher 

percentages to 100%, accompanied with a beep. If an error is made, the cursor can be 

moved up or down the list using arrow keys or the mouse.

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears in 

the cell with the grade. If the grade was already marked Late, the "L" disappears and the 

grade is no longer late.
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Number Wrong Entry

The Number Wrong Entry method is the reverse of the Number Correct Entry. After 20 

possible points is entered, an individual entry of 1 will be interpreted as 1 missed. The 

computer then calculates the 95%. (Limit: 999 Points)

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears in 

the cell with the grade. If the grade was already marked Late, the "L" disappears and the 

grade is no longer late.
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Number Correct Entry

The Number Correct Entry tells the program that you want it to figure percentage grades 

for you based on total correct on an assignment. Number Correct is the opposite of 

Number Wrong Entry. The Assignment Information Screen, asks for the total possible on 

the assignment. If 20 possible points is entered, and an individual grade 19 is entered, the 

computer does the conversion and 95% will be displayed. 21 points returns 100%. (Limit: 

999 points)

When entering grades, other symbols can be entered which may be helpful in identifying 

missing assignments.

I= INC (Incomplete)

A= ABS (Absent)

N= N/A (Not applicable)

B= Blank

CTRL+any action that moves the cursor to a new cell toggles a Late and an "L" appears in 

the cell with the grade. If the grade was already marked Late, the "L" disappears and the 

grade is no longer late.
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Rubric Entry

Choosing Rubric Entry from the Assignments Menu "invokes" the Standards-Based

grading power of PGGP.   Rubric Entry is the best of all worlds.

1. Rubric Entry combines Quick Entry and Number Correct.   If you choose a point

scale of under 10 points, PGGP acts like you are in Quick Entry mode, advancing 

to the next students with each key press.  If you choose a scale of 10 or

more points, you will have to press Enter/Return after each entry to advance.  You

can enter 2 to 100 points in rubric scale, although it makes more sense to keep the 

scale at or above the number of Performance Indicators in the Rubric Formula.

2. Rubric Entry you to attach a standard to the Assignment.   You do not have to

attach an assignment or assessment to a standard.   If you do not, then it remains

unattached and is for information only, and not calculated.  If a standard is chosen

for the assessment, then PGGP automatically starts a new standards group to keep 

track of the student's progress in that standard.

3.  If your school or district does not want standards "averaged" then you can

choose "Limit Standards to One" in Preferences.   PGGP will then allow only one

assessment per standard.   Instead of add assessments for the standard, you

would change the student's current score to reflect progress on that standard.

4. Rubrics can also be treated as "True Rubric" or the driver's test scenario.  When

you take your driver's test, if you can accelerate, turn left and right but can't stop, 

you don't get a driver's license because you have not mastered all the standards for 

the test.  Likewise, True Rubric calculates the grade for a subject to the lowest

grade for one of the standards.  This makes some parents and teachers nuts, but is

a feature that your district may feel is valid.

4.  You cannot set a weight of a Rubric Scored item.   This just did not seem to

make sense when thinking about standards.
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Behavior Entries

The Behavior Module of PGGP is designed to help teachers keep a record of student 

behavior.

There are two types of information that can be entered into a behavior column:

1) Define criteria ( Behavior Definitions) and give students behavior demerits based on that 

criteria.

2) Enter percentages in the cells.

You cannot mix the type of information within a behavior column.

PGGP will expect you to enter the Behavior information as explained in choice number 1. 

Each time you start a new column PGGP will ask you which type of behavior entry you 

plan to use. If you only plan to use choice #1 exclusively there is a "Stop Asking" check 

box. If you plan to use Choice #2, you will have to put up with the choice box.

Clicking on the status bar (up where the date is) will always bring up the Behavior Choice 

Dialog. You can use this technique to change the way a column is entered or to change 

your mind about "Stop Asking". Changing the way a column is entered resets the column's 

grades to 100%.

Some Ideas About Keeping Behavior

The module was intended to be used daily to record student behavior problems. There are 

other ways to use the behavior module.

Daily use: To select a student, click on the cell for the date you wish to record an 

indiscretion. If there are not dates PGGP will help you assign dates to the columns. When 

the dialog opens, you can click on the triangle and use the calendar to select the date. 

Dates will be assigned to each column, excluding weekends.

If dates have already been assigned, clicking the the intersection of name and date, a 

dialog will appear. At this point you can click on the up and down arrows to assign demerits 

to the student in question.

The Entry Screen is also available as in other subjects. When the double column Entry 

Screen it available, students can be assigned group grades as in any other subject. In 

addition to using group assignments, it is possible to select a group of students for a 



demerit entry. Holding the shift and clicking on multiple students causes the students to be 

selected. The next entry (click on any student's grade cell) will be assigned to this ad hoc 

group.

Variations on the above have been invented by teachers who like giving weekly grade. To 

make the columns contain weekly grades, such as Friday's, simply click on the column on 

the day you wish to enter the grades. Then select the day with the calendar. The column 

will be dated and ready for entry. This technique can also be used to skip vacations or off 

track times for year round schools.

For more information you may want to visit the PGGP web site and read about Behavior in 

Three Minutes a Day.
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Using the Behavior Calendar

If there are not dates PGGP will help you assign dates to the columns. When the dialog 

opens, you can click on the triangle and use the calendar to select the date. Dates will be 

assigned to each column, excluding weekends.

The dates start from the column you are currently on and are added to all columns to the 

right. This makes it possible to create any string of dates you wish for columns.

To make the columns contain weekly grades, such as Friday, simply click on the column 

for the day you wish to enter the grades. Then select the date with the calendar. The 

column will be dated and ready for entry. Columns to the right will contain a run of dates, 

but next Friday you can set the date for that column. This technique can also be used to 

skip vacations or off track times for year-round schools. If you want to eliminate Christmas 

vacation, click on the date one day after the last day before vacation. Use the calendar to 

choose the first day back after vacation. The dates will now skip over the days not in 

school.
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Marking Assignments Late

Assignments be marked late at any time by holding the control (ctrl) key anytime you are 

moving t a new cell. This can be just pressing a number when using Quick Entry, pressing 

return when using any entry method. Clicking on another cell while holding the control key 

will also mark an assignment late. A late cell has a small L in the corner of the cell.

Using the control key toggles the late mark. If the paper is already late then it is unmarked. 

An unmarked cell is marked.

The penalty for a late assignment can be set in Preferences in the Settings Menu.

Special consideration must be given to using a group grade created by holding shift. The 

toggle rules above, will be kept in effect in the current entry cell and distributed to the 

group. In other words, if that student already has a grade and that grade is late, then all will 

get the late grade. If the student's grade was late, and you attempt to give the group a late 

grade by holding down CTRL, the existing late will be undone and the group grade will not 

be marked late.
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Group Grade Entry

When working with cooperative learning groups, it is possible to enter grades by group. 

Each subject allows separate group membership for each student.

Start a new assignment entry. The middle of the screen contains the Group Entry Buttons.

From top to bottom there is a Group Entry Box, A button for each group, a Group Button 

and a Done Button.

Putting an X in the Group Entry box will activate the buttons.

Clicking on the Group Button will change the screen to a Group Entry Screen. After clicking 

on the Group Button start at the first student, and assign each student a group number. 

Selecting zero will cause a student to not be assigned to a group. Either the number row or 

the 10 keypad can be used to assign group numbers. Click on Done to return to the Grade 

Entry Screen.

To enter a Group Grade, click on a group button, e.g. Group 1. All students in that group 

will be marked and the next grade entered will be given to the group. The group will be 

unmarked. At this point the user may enter either a single grade for a student or another 

Group Grade by clicking on another Group Button.

If you highlight a group and decide you do not wish to enter a group grade, click on 

Ungroup.

A temporary group can also be created by holding shift and clicking on a student's grade 

entry column. The student will be highlighted. After the group is created any grade entered 

will be distributed to the highlighted group. This can be especially handy when entering 

behavior grades, when there has been an incident involving several students.
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Insert

Insert will insert a column of grades. A dialog box is displayed asking if this is the users 

intent. Radio buttons allow the user to choose the method of entry. When the user answers 

OK, the Grade Entry screen will appear. The grades entered will be inserted at the current 

column number. The existing column and all columns to the right will be moved to the right.
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Delete

Delete will delete a column of grades. A dialog box is displayed asking if this is the your 

intent. If the you answers OK the Column is deleted, the columns to the right are moved 

one column to the left, and the grade book is recalculated.
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View Assignments

View Assignments places the name of the student currently active, and each date, 

assignment, percentage, and grade for the assignment. This is a screen version of Student 

Summary found in the Reports Menu. On Windows the summary can be printed by clicking 

on the little printer icon on the upper left of the screen.  To Print this report on Macintosh

computers, use Student Summary.
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Return To Assignment

Return To Assignment allows a close-up view of an assignment. The original grade screen 

is reproduced, with existing grades. This is useful when making several changes in a single 

assignment.

When returning to the Grade Entry Screen the computer places AN ESTIMATE of the 

original raw score when using Number Wrong or Number Correct. (Trying to reverse 

engineer a rounded number, can cause an occasional 1 point difference. The number 

displayed will result in the existing percentage score.)

A much Quicker way to Return To Assignments is to click on the entry number at the top of

a column on the grade book screen.
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Remove A Student

Remove A Student erases the name and all entries for a given student. Note this can be 

either a global function removing the student from all subjects , or effect the grades in the

subject on the screen only.   If you don't like the blank left in the grade book, you can Sort 

The Class in Preferences.

This is permanent.
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Reports Menu

The Reports Menu allows the user to access paper reports and letters. Make sure a printer 

is installed.
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Student Summary

First, it is important to know that this entire report can be added to a Letter with one click of 

the mouse.

Student Summary prints a report of each assignment for a given student. The report 

attempts to format the headings in the student's home language. If the headings do not 

seem proper, check Various Translations to be sure you have provided the correct 

translations.

It is possible to control both the type of information printed and the range of dates which is 

printed.

At the top of the dialog is a popup menu for quick selection of a student.

Clicking the button for the current subject will print the assignments for just that subject.

The What To Print section allows you to print all assignments or selected assignments. If 

Selected Assignments is chosen, then only the items with a check will be printed. If you 

chose Print INC and Print ABS then an assignment with 73% would not be printed.

To the right you can choose the range of dates to be printed, using Start Date and End 

Date. Please note that dates must have been entered correctly for the assignments. It is 

suggested that you use the calendar to add dates to avoid disappointment, Typing in 

3-5-05 and 3/7/05 will invite disappointment. PGGP does its best to correct this sort of 

thing, but it is amazing how teachers can trick the system and enter some of the strangest 

things for dates.
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All Grades

Selecting All Grades prints a mini report card. Each student and all grades are placed in 2" 

X 4" squares ten per page. The report includes GPA, At Risk notice, all subject grades... 

with either Effort Grades or Average as a Percentage, Behavior, Study Skills and 

Attendance information.

These mini reports can be attached to agenda books, home work folders or a Record 

Sheet.
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Grades In Rows

Selecting Grades In Rows prints the student's name followed by grades and Averages for 

each of the first eight subjects. The name and all grades are on one line. The font size is 

reduced to allow all the grades to be printed. This is actually an old report from the days 

when PGGP only held eight subjects. During testing, I removed it and there was such a cry, 

I put it back in. Grades In Rows only prints the first eight subjects.
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Standards

The Standards Analysis Report will print each standard taught, by subject for a student.  The subject is printed

with an average for the subject (and the Traditional Grade if traditional grading is used).  Each standard

graded is printed followed by the number of times it has been assessed.  A bar graph then displays the

proficiency for the standard.
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Standards Analysis

The standards analysis is a teacher report, showing the standards taught, by subject, the

number of times assessed and the average proficiency for each standard.  This can help

determine which standards need to be revisited.   Preferences settings, Use Latest and

True Standards will alter the results of this report.
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D-List

Selecting D-List prints a simple "D" list. Each student currently having a grade less than C- 

in any subject is listed, and the and subjects having D grades or Lower will be reported. 

This is keyed off the 10th percentage in the Formula Tables.
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Letter

Selecting Letter allows a letter to be printed. If no letter has been selected, the standard 

Open File dialog box is presented. Select a letter you have prepared, or click on cancel.

To find out more about creating letters, select the topic, Preparing Letters.

Next a dialog box will be presented that allows a great deal of flexibility in letter printing. 

The default setting prints all letters for students getting grades lower than C- in any subject.

In the upper left, there are four radio buttons allowing the user to choose which language

they want to work with. If only one language is being used, only one button is active. As the 

user prepares to support other languages, the radio buttons will become active. The 

language settings can be accessed in the Settings Menu.

The lower left of the box displays radio buttons in pairs, allowing the letter printing to be 

customized further.

1) The first set of radio buttons change the sort status, from "grades lower than" to "grades 

equal to or better than". It is important to understand the logic offered here. Lower than 

prints letters for any student having even one lower grade. Equal to or better than prints 

letters for students having ALL grades equal to or better than the selected grade setting.

2) The second set of radio buttons cause the program to print the letter to the screen rather 

than the printer.

3) The third set of radio buttons allows the user to print letters for selected students or the 

entire, sorted, list. The up/down control, in the middle of the dialog box, works in 

conjunction with the third set of radio buttons. When the program is set to sort the whole 

class list, the up/down control changes the grade cut. When the program is set to select 

letters for single students, the up/down control scrolls up and down the class list.

4) The last set of radio buttons sets the sort criteria.   You can sort by Letter grades or

Rubric Grades. 

The Print button on the right of the dialog box starts the printing process. The Get A Letter 

button allows the user to change letter titles. The letter will be assigned to the currently 

selected language. The Get A Student button works in conjunction with the third set of 

radio buttons. When the program is set for individual students, it produces a list of 



students. Clicking on a student, or typing the student number selects the student for 

printing. Clicking on Editor brings the selected letter into the editor. The Done button 

disposes of the dialog box.

Alas, PGGP is not very good at reading letters across platforms.  In other words, a Letter

written on Windows does not read into the Mac PGGP very well.   Sorry, I am just not that

smart.
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Preparing Letters

The letter editor is found in the Reports Menu, under Letter. To write or edit a letter, click 

the Editor button

The Letter Editor allows you to use fonts, sizes and styles in your letters. While standard 

Note Pad style word processing techniques have been employed here, this is not a full 

word processor, so extra large sizes may cause unpredictable results. It is suggested that 

you place <<Grades>> and <<Assignments>> next to the body of the letter, with no blank 

lines.

The buttons at the right allow the user to insert <<Merge>> type fields into the letter. 

Please note that the merge buttons allow correct case and gender merges (in four 

languages, according to the translations provided in the Translation Tables) appear in the 

letters. Note that if a student is assigned the wrong language or gender, the program 

cannot merge the proper words into the final letter.

For a more detailed explanation of letter writing, visit the PGGP site on the web: Letter Tip

Table Of Contents

http:\\www.pggp.com\letter_tip.htm


Table Of Contents

Name List

Choosing Name list will print student names in the style you have chosen in Preferences.  

The names will be printed in four columns so you can cut them into strips to save paper.  

This is handy for events such as Valentine's Day.
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Record Sheet

Selecting Record Sheet prints a lined record sheet on which students glue weekly All 

Grade Printouts. Copy one for each student. Teachers may require this sheet to be 

initialed and returned each week. This simple reporting method saves paper and gives 

parents a running record of student progress throughout the grading period. This has 

proven to be VERY effective.

This corresponds (as best I could) to Avery 2" X 4" labels, #8253
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Row Grade Sheet

Selecting Row Grade Sheet prints a lined record sheet on which students glue weekly 

grade strips cut from the grade printout. Copy one for each student. The first week, 

students glue their name and grades on line one of the sheet. Teachers may require this 

sheet to be initialed and returned each week.
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Print Student Database

Selecting Print Student Database places student information on a landscape printout. This 

can be a handy list of student addresses, phone numbers, and birthdays.
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Printing Group List

Selecting Print Group List will print a sheet listing each Cooperative Learning Group and its 

members.
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Semester Average 

A Semester Average utility has been included, however, an accurate semester average 

can be tricky.  You must be sure the files contain information that can be averaged.  PGGP

attempts to check for the following possible flaws and prints error codes.

  

 ERROR IN NAME: Indicates a mismatch in the student name.

 "?" will appear in place of the first grade character if there are no grade entries in

the first quarter.  "Error" will be printed in place of the Average.

 "?" will appear in place of the second grade character if there are no grade entries

in the second quarter.  "Error" will be printed in place of the Average. 

   The second file controls the semester average: the order of the students and subjects

and the grade formulas.

   Please note that the percentages on a regular printout indicate rounded numbers.  For

the Semester Average, the real scores for each subject are averaged and then rounded for 

a semester average.
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Report Card Time  (RCT)

Finally, Elementary Report Cards done right.  PGGP gives you the best of both worlds:  the

web and a computer application.   PGGP resides on your computer, making it fast and

easy to use, even when you are not on the Internet.   When you want to post grades on the

Internet, PGGP lets you fill out a simple form once and quickly upload grades by term. 

RCT is hosted by the PGGP web site and keeps each term ("quarter") in the RCT database

so cards build naturally.   Several generic cards are available and exact duplicates of your

school or district's card can be built. 

You can upload and create report cards quickly.   The cards are saved on your desktop as

pdf files.  These can be printed and archived for future use.  PGGP has a quick comment

feature that allows you to add detailed comments to report cards quickly.  Instead of

enduring the writing of each card by hand, take a look at Report Card Time. 

RCT is offered via a yearly subscription fee.

Because RCT is on the Internet,  RCT Help on the PGGP website.

Report Card Time is an added section to Online Grades,  a Source Forge project created 

to help teachers and parents communicate.   The mySQL and PHP programming was

done by Robert Dodge.   I create the report cards.
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Export Grades

 PGGP can export the final grades to a database.   One popular database is FileMaker but

the exported file can be opened by excel or a database of your choice.
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Online Grades

Online Grades is a Source Forge project created to help teachers and parents

communicate.   PGGP uses a modified version of Online Grades and is hosted by the

PGGP web site.   Much thanks is given to the creators of Online Grades.   From the time I

was contacted asking if I was interested in making PGGP compatible with Online Grades 

to the final installation, I have found the Online Grades team very kind and helpful.  Sam

Snow, of the Online Grades project has been a strong guide.

PGGP gives you the best of both worlds:  the web and a computer application.   PGGP

resides on your computer, making it fast and easy to use, even when you are not on the

Internet.   When you want to post grades on the Internet, PGGP lets you fill out a simple

form once and quickly upload grades.   Because Online Grades is on the Internet, PGGP 

Online Grades Help on the PGGP website.

PGGP Online Grades is offered via a yearly subscription fee.   Free hosting may be

available via Source Forge, however I will not be able to help you use their server.
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Settings Menu

PGGP allows a great deal of flexibility for the teacher. The Settings menu provides access 

to the Number of Students, Effort Formula, Grading Formula, defining the value of Letter 

Grade when using Quick Entry, Excluding Subjects from the GPA, setting up Languages, 

providing PGGP with Translation Tables and Preferences.
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Number of Students

Choosing Number Of Students produces a dialog that allows the number of students to be 

increased or decreased. While this does not effect the main grade screen, it does limit the 

Grade Entry screen, and the All Grades report. If you have less than 32 students, you can 

save paper by limiting the students to the number currently enrolled. The number can be 

increased when new students arrive.
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 Quick Entry Setting

Choosing Quick Entry Setting presents a dialog box that is connected with the Quick Entry 

of assignments.   If you choose 98 percent, an A will be assigned 98, a B will be assigned

88, etc. when using the Quick Entry.
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Formula Tables

PGGP uses five sets of formulas to calculate grades.   While this may seem like needless

complexity, it allows teachers to easily report a variety of grades.  You may not use all of

them, but they are there for your use.  All the formulas come with a default set up.  Many

teachers find that fine.  Others think PGGP is way off base.  You can change the formulas

in any way as long as it is logical.

Academic Formula provides for traditional AB grading.  PGGP uses this formula for

subjects marked Academic in the set up. 

Academic Effort Formula provides for a unique grading opportunity that other grade book

rarely provide.   PGGP will also figure an Traditional Effort grade (E's and O's) on subjects

marked Academic in the set up.  This grade is based on how many subjects are not late

and not incomplete (INC).

Effort Only Formula provides for traditional E and O type grading.  PGGP uses this formula

for subjects marked Effort in the set up.   Note that PGGP uses only one set of E and O

symbols, shared with Academic Effort, Effort and Behavior.

Rubric Formula provides for standards-based grading.  You can use descriptors like Basic

and Below Basic along with either a 100 point scale or a rubric scale.  This formula will be

used for any assessment that uses the Rubric Entry and can be mixed in with either 

Academic or Effort subjects as you choose.  Academic or Effort grades will never appear if

you use purely Rubric Entry for all assessments.

Behavior Formula provides a special scale to be used in the behavior module.  It shares

symbols with Academic Effort and Effort Only.   While some teachers turn off Behavior, you

may want to take a careful look at this unique feature.   You can keep an accurate, by day,

record of behavior for all students in less than three minutes a day.  The PGGP web site

has an article about behavior in three minutes a day.  The tutorial there uses a "card

system" but can be adapted to any set of behavior incidents.
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Academic Formula

Grade Formula allows the default grading scale to be altered. The existing scale will be 

displayed. Study the existing scale and plan the new scale carefully. Letters, e.g. "B+" may 

be altered to any two characters such as O's and S's for each position. Numbers should be 

between 1 and 100. The third column allows the user to apply a GPA value to each grade. 

It is assumed that the standard 4 point scale will be used. See Logic for an explanation of 

academic and effort grade computations.
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Academic Effort Formula

Effort Formula allows the default effort scale to be altered. The existing scale will be 

displayed. Study the existing scale and plan the new scale carefully.

The Percent of Assignments Complete column calculates the number of assignments 

containing the grade INC or Marked Late. If the percentage complete and on time is at or 

above the percentage shown, the student will receive the effort grade to the right.

The Cutoff Point By Percent column looks at the students current Average in the subject. If 

that average is at or above the percentage shown the student will receive the effort grade 

to the right. NOTE that this is an and function and either case can yield a lower effort 

grade. INC combined with other marks can create some interesting Logic problems.
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Rubric Formula

In the examples below the formulas are both for schools using 5 Performance Indicators. This is 

for example only and you may use other configurations. Remember, this formula is so PGGP 

can give Performance Indicators for student reports. You can assess an individual assignment 

using 20 points and PGGP will convert the 20 point assessment into 5 (or what ever you are 

using) point Performance Indicators.

Rubric formulas can be entered two ways. One uses pure rubric numbers, and could be 

5=Advanced, 4=Proficient, 3=Basic, etc. Make sure the formula you enter makes sense 

mathematically

The second method converts the rubric scale to a 100 point scale. 5 will equal 100, and 2=40, 

etc.
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Effort Only Formula

The Effort-Only Formula sets the percentages that render the Effort Symbols (Symbols are 

set in Academic Effort Formula. On many elementary grade cards Effort-Only grades 

single cell grades such as PE or Art. It is important to note that only one set of Effort 

symbols is used for Academic Effort, Effort Only and Behavior. Once you decide on the 

symbols that best fit your situation, manipulate the percentages to achieve what you want.
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Behavior Formula

The Behavior Formula sets the percentages that render the effort symbols set in the 

Academic Effort Formula. The behavior formula is also controlled by the Behavior 

Definitions. Feel free to experiment with the formula. Remember any changes made here 

are instantly reflected in the behavior grades. As with all formulas, this makes it possible to 

try some combinations and look at the grades and students. You will soon know if your 

numbers are giving the students the kind of grades they deserve.
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Behavior Definitions

Behavior Definitions give the teacher five slots to enter generic behavior problems for 

which students might be given demerits. The top, sixth slot, contains Suspension. 

Suspension is hopefully the strongest result of uncooperative behavior. Suspension can be 

given once daily. Other infractions may be recorded up to 8 times daily.

Because each student is given 100% per day if their behavior does not warrant a demerit, 

you may find that you want to make the demerit penalty steep for infractions. Behavior 

Formula drives the grades given for Behavior.
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Exclude From Entry

PGGP has two types of traditional subjects, Academic and Effort Only.   This determines

which grading scale will be applied.  Academic Grades actually contain two grades, the

traditional (A, B) and and Effort (perhaps E, S type grades).   Study Skills is an average of 

the effort grades in subjects that are traditionally academic.  By choosing Exclude From

Average the user can eliminate a subject from the GPA computation when the grades are 

printed. It also decides if a subject will be figured into the Study Skills grade.    An X beside

a subject includes it in the GPA and Study Skills.
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Translation Tables

Choosing Translation Tables produces a dialog that allows setting up for as many as four 

home languages.  Think in terms of what will make it easiest for parents to understand the

various reports and letters you may send home.   Note that some are case sensitive such

as His and his.   Choose the number of languages to be supported and then press tab to

begin translating the Subject Titles. Use the tabs to fill in other translations.   (Sorry PGGP

does not translate for you; I am not that smart.)   Click Done when finished. 

Note:  If you are using Easy Setup, clicking Done will move you to the next translation table

as if you clicked the tab for that set of words.
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Set Student Cap and At Risk

The Student Cap provides you with a way to notify parents that their child is working below 

grade level and is At Risk. The Grade Entry screen appears and a single percentage can 

be entered next to each student. This percentage can perform two functions: 

1. The student will have an * beside the grade for the subject. If any subject is 

capped, "*=At Risk" appears on the All Grades grade square. 

2. If Student Cap On is checked the final average is capped at the level set. If 

Student Cap Off is checked in Preferences, then only the * appears next to the 

letter grade.

Note that only the final average is affected by the cap. While capping grades may not be 

desirable, it you may find it useful to print All Grades with Cap On and Cap Off and 

compare the two. Many teachers are struggling with how to handle new retention laws. 

Grade inflation has taken grades to the point where it is possible for a student to get B's 

and C's and yet be facing retention due to scores on Achievement Tests.
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Preferences

Checking Use Attendance puts attendance in the subject menu and in reports

The buttons on the right allow the user to configure how the names are printed.

Use Study Skills puts Study Skills, an average of the effort grade of academic subjects, in 

reports.

Cap On will limit the top score a student can receive. This is related to Set Student Cap in 

Settings Menu. Setting Student Cap will turn on the "At Risk" *. If Cap On is checked the 

student will also be limited to the cap entered in the Settings Menu. (I know, clear as mud.)

Checking Percent will print a percentage in academic subjects that do not have any 

Standards (Rubric) grades.

True Standards will limit a student to the lowest standard of a subject...the thinking being 

the student who has a Below Basic (2) in Writing has not mastered the standards for 

Writing. With out the check, standards are averaged (but not rounded) for the subject. 

(This is an odd one, I call the Driver's Test of Grading.  You can read more at the PGGP

web site about Standards.

Limit Standards to One will keep PGGP from allowing a standard to be used more than 

once in a subject. This could be useful by revisiting a standard when reassessed rather 

than putting it in again and averaging.

Use Latest Assessment (vs Average) causes PGGP to use the latest entry (by column, not 

by date) for each standard grade.    If unchecked PGGP averages, without rounding, each

standard for the grade for that standard.  The resulting standards grades are averaged but

not rounded up for the subject grade.  This averaging is done according to the True

Standards setting, above.

Selecting Printer Margins allows you to make some corrections by moving the document 

on the paper

Selecting Password allows the user to begin using a password. Once a Password as been 

entered, there is No Way to reverse the process. For safety the password will be tested 3 

http:\\www.pggp.com\standardsravings.htm


times before allowing you to begin using the password feature. Remember your password!

Selecting Define INC/Late allows the percentage entry value for an Incomplete and Late to 

be set. If you Do Not Wish INC to be calculated, remove the X from The Activate 

Incomplete box. Setting up the Late penalty is very similar. By activating the Late Penalty, 

you can set the penalty of a late assignment. To not use the late penalty, remove the X 

from the box.

Selecting Set Upper Limit will allow PGGP to accept grades up to 115%

Selecting Sort The Class presents two choices: Alphabetizing the class list and returning 

the class list to the original order. When the students are alphabetized, you may want to 

change to LastName, FirstName for a typical sort. Names are sorted according to the way 

they are being printed. You can sort and then put the names back First Name, Last Name.

Selecting Upper Limit will set the highest percentage allowed for assignment.
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Setting Up For Languages

PGGP does not translate.   However, English and 3 other languages can be merged into

reports and letters.

Various Translations in the Settings Menu lets you set up the translations. Begin tabbing 

through the fields, translating the words. These translations will be used in the letter. Note 

that the translations are gender and case specific in some cases.

Currently, none of the state or federal standards have not been translated.   If you have a

set of standards that have been translated to a language supported by your school, been

translated, please contact me and I will see what needs to be done to integrated them into 

PGGP.
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Subjects Menu

The Subjects Menu allows you to change between as many as 16 subjects, two behavior 

and one attendance module.  You can also change the order of the first 16 Subjects.
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Miscellaneous Topics

There are some topics that do not fit in the regular scheme of the help file.
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The PGGP demo file you have been using has timed out. All your information is safe, and 

when you purchase PGGP you can continue as if you never used the demo. Unfortunately, 

setting your computer clock to another time will not help. 

If you are desperate (this often happens at the grand moment of Report Card Time) I can 

send you a download location when you purchase PGGP...to speed up the process a little 

bit.

 

Things To Know

PGGP was written by a 6th grade teacher. The first copy was sold in September of 1987. 

The main purpose was to write a program that prepares grades for the elementary teacher. 

That was the objective, and so far users find this is exactly what the program does!

TECH SUPPORT:

You can contact me at via e-mail:

gbeckman@pggp.com

or

(559) 674-7848

U.S. Mail should be directed to:

George Beckman

22353 Ave. 18 3/4

Madera, CA 93637

Watch for Updates and News at:

http://www.pggp.com

ORDERS:

Orders: M-F, 8-5 CST

1-800-520-7768

Visa/Master Cards Accepted

mailto:gbeckman@pggp.com
http:\\www.pggp.com


District Purchase Orders Accepted

Fax 228-255-7086

Send Checks To:

STAZ Software- PGGP

4387 Leisure Time Drive,

Diamondhead, MS 39525-3215

Site Licenses are available and P.O.s are OK.

Single: $49.00

Limited Site: $189.00

Full Site: $349.00

(Mac and Windows)

I am always happy to address any problems you may come across. If you think you have 

found a bug in PGGP, please contact me or go to the web site and look under Updates and 

Questions.
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    Liquid Ambers

   

They were planted

The year I was born

And we grew there, together.

They lined the drive

Marking the path home.

        

In the fall, they turned

A glorious rusty red

White-grey and straight

Dressed in Amber.

And the place got buried.

   

But this fall,

In an old music book,

On page 370 

I found a perfect leaf

Marking the memory home.

   

© George Beckman

01/02/93

 

This driveway led to my home for 18 years. 

My home was located at the mouth of San Dimas Canyon, in La Verne,

California. 

The place was beautiful, and it was buried under 75 feet of silt 

removed from the San Dimas Canyon Reservoir. 

Now I live happily with my wife on 5 acres in Madera, CA.
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This is a Timed Demo of the Pretty Good Grading Program. I hope you find it useful. If you 

wish to continue using PGGP please contact Staz Software by phone, mail or order online. 

(See information below)  Even if this grade file will not open, think of it as Sleeping

Beauty.   The real PGGP will waken it with a magic kiss and you will live happily ever after.

If you are desperate (this often happens at the grand moment of Report Card Time) I can 

send you a download location when you purchase PGGP... to speed up the process a little 

bit.

 

Things To Know

PGGP was written by an elementary teacher. The first copy was sold in September of 

1987. The main purpose was to write a program that prepares grades for the elementary 

teacher. That was the objective, and so far users find this is exactly what the program 

does!

p.s.  I retired from education in 2005 after 35 years in the business.   I now have more time

to work on PGGP and my wife and I are enjoying ourselves very much..

TECH SUPPORT:

You can contact me at via e-mail:

gbeckman@pggp.com

or

(559) 674-7848

U.S. Mail should be directed to:

George Beckman

22353 Ave. 18 3/4

Madera, CA 93637

Watch for Updates and News at:

http://www.pggp.com

mailto:gbeckman@pggp.com
http:\\www.pggp.com


ORDERS:

Order Online at:

http://www.pggp.com/orderinfo.htm

Phone Orders: M-F, 8-5 CST

1-800-520-7768

Visa/Master Cards Accepted

District Purchase Orders Accepted

Fax 228-255-7086

Send Checks To:

STAZ Software- PGGP 

320 St. Charles St., 

Bay St. Lewis, MS 39520

Site Licenses are available and P.O.s are OK.

Single: $49.00

Limited Site: $189.00

Full Site: $349.00

(Mac and Windows)

I am always happy to address any problems you may come across. If you think you have 

found a bug in PGGP, please contact me or go to the web site and look under Updates and 

Questions.
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Print Student Database

Selecting Print Student Database places student information on a landscape printout. This 

can be a handy list of student addresses, phone numbers, and birthdays.
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Online Grades

PGGP can place grades on a secure server for parents to view.   The tutorial for Online

grades is, well, online:

http://www.pggp.com/onlinegradeshelp.htm

If you are interested in using this feature, contact George.

http:\\www.pggp.com\onlinegradeshelp.htm
mailto:gbeckman@pggp.com
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